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Terms and Conditions for use of McBreach© 
 

By installing McBreach to your computer, you agree to the following terms: 
 
Kleinschmidt Associates, Inc ("Kleinschmidt") grants to you (“the User”) the rights to 
install McBreach "the Software" and to use the Software subject to the following Terms 
and Conditions for Use (“the Agreement”): 
 
All copies of the Software received by user pursuant to the authority of the Agreement 
will be and remain the property of Kleinschmidt. User may not reproduce, distribute, 
rent, lease, or lend the Software without prior authorization from Kleinschmidt. 
Kleinschmidt is solely responsible for the content of the Software. The Software may not 
be modified, abridged, decompiled, disassembled, unobfuscated or reverse engineered.  
No part of the Software may be exported or re-exported in contravention of United States 
of America’s export laws or regulations. 
 
Waiver of Warranty 
KLEINSCHMIDT AND ITS AGENTS, OFFICERS, REPRESENTATIVES, AND 
EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE THE 
SOFTWARE "AS IS," WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, 
IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM ANY IMPLIED 
WARRANTIES OF TITLE, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. 
 
Limitation of Liability 
IN NO EVENT SHALL KLEINSCHMIDT, ITS AGENTS, OFFICERS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND 
SUPPLIERS, BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN CONNECTION WITH 
USE OF THE SOFTWARE REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE 
EVEN IF KLEINSCHMIDT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 
KLEINSCHMIDT AND THE LIABILITY OF ITS AGENTS, OFFICIERS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND 
SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY CIRCUMSTANCE IS 
LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF THE SOFTWARE 
WITH IDENTIFIED ERRORS CORRECTED.  
 
Indemnity 
As a voluntary user of the Software you agree to indemnify and hold Kleinschmidt, and 
its agents, officers, representatives, and employees, including its contractors and 
suppliers, harmless from any claim or demand, including reasonable attorneys' fees, made 
by any third party due to or arising out of your use of the Software or breach of the 
Agreement or your violation of any law or the rights of a third party. 
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Modifications 
Kleinschmidt reserves the right to modify the product over time without notice and shall 
not be under any obligation to provide you with any notification of such change nor 
provide an archive of prior versions. 
 
Support 
The Software is provided with no support, either contractually or implied. Support 
services are available by contacting Kleinschmidt. 
 
Duty of Care 
As a user of the Software, you agree to use sufficient duty of care when using the 
Software. This includes not designing or constructing anything outside of your abilities 
and knowledge.  
 
Entire Agreement 
The Agreement, including any and all documents referenced herein, constitute the entire 
agreement between Kleinschmidt and the user. Kleinschmidt’s failure to insist upon or 
enforce strict performance of any provision of the Agreement shall not be construed as a 
waiver of any provisions or right. If any of the provisions contained in the Agreement be 
determined to be void, invalid or otherwise unenforceable by a court of competent 
jurisdiction, such determination shall not affect the remaining provisions contained 
herein. The Agreement shall be governed by and construed in accordance with the laws 
of the state of Maine and the federal laws of the United States of America applicable 
therein. 
 
Assent 
Choosing the “I agree” option and selecting the “Next” button during installation of the 
McBreach software indicates that you have the authority to accept the Agreement and 
voluntarily accept the terms and conditions contained herein. If you do not agree or have 
the authority to agree to the Agreement, please delete all copies, and cease using the 
Software. 
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I.  Introduction 

McBreach is a companion software application to the Hydrologic Engineering Center’s 
River Analysis System (HEC-RAS) that performs probabilistic dam breach modeling. 
Using McBreach, the hydraulic modeler has the ability to randomly sample, about 
predefined statistical distributions, all breach parameters for inline structures, lateral 
structures and SA/2D Area Connections.   In addition to breach parameters, the user can 
include the model’s inflow hydrograph in the probabilistic analysis by randomly 
sampling hydrograph flow and duration multipliers.   
 
Through a Monte Carlo simulation, McBreach produces exceedance probability peak 
discharges and their respective sampled breach parameters that can be used to produce 
exceedance probability inundation (EPI) maps. Ultimately a design exceedance 
probability peak discharge is selected for decision making. Several metrics are available 
for the user to gage statistical convergence during the probabilistic simulation.   
 
Using the techniques presented by Goodell (2014), McBreach communicates with HEC-
RAS and exchanges information at the realization level. The connection with HEC-RAS 
is managed through use of the HECRASController, as well as programmatic 
reading/writing of the HEC-RAS input files.   
 
McBreach satisfies a need in the dam safety community to augment the overly 
conservative deterministic approach to dam breach modeling with a probabilistic 
approach that quantifies uncertainty in the analysis. McBreach allows for decision 
making based on risk and uncertainty and compliments dam safety jurisdictional desires 
to move towards risk-informed decision making. 
 

II. Requirements 
To use McBreach, the user must have a licensed copy. McBreach Version 5.0.7 software 
will run on Windows™ XP™, Vista™ SP2, 7 SP1, 8, 8.1, and 10 with Microsoft .Net™ 
Framework 4.6.1 or higher. Most new computer systems use .Net™ Framework 4.6.1 or 
higher; however, if necessary, .Net™ Framework 4.6.1 and higher can be downloaded for 
free from https://dotnet.microsoft.com/download/dotnet-framework. HEC-RAS Version 
5.0.7 is required to use McBreach Version 5.0.7. Because McBreach is designed to run 
many thousands of HEC-RAS simulations autonomously, computer speed and efficiency 
is most important to minimize overall run-times. While not required, it is advised to use a 
computer with superior processing speed and random-access memory (RAM). At a 
minimum to handle .Net Framework 4.6.1 your computer must have the following: 
 

Processor:  1GHz 
RAM:   512 Mb 
Free Disk Space: 4.5 Gb 

McBreach Version 5.0.7 is available free of charge. However, to use McBreach Version 
5.0.7, the user must agree to terms and conditions, as outlined on pages ii and iii of this 
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manual. By installing McBreach Version 5.0.7 onto your computer, you agree to the 
terms and conditions included in this manual.   
 

III. Installation 
The McBreach installation file can be downloaded from the Kleinschmidt website at 
https://www.kleinschmidtgroup.com/mcbreach/.  To install McBreach, double-click the 
McBreach507.msi installation file and follow the prompts on the install wizard. If a 
previous version of McBreach is already installed, the user may be required to uninstall 
the older version prior to installing the new version. Before McBreach can run, HEC-
RAS Version 5.0.7 must be installed on the computer. HEC-RAS Version 5.0.7 can be 
downloaded from the Hydrologic Engineering Center’s website 
(www.hec.usace.army.mil). 
 

IV. Starting A New McBreach Project 
To start a new McBreach project, double click the McBreach icon on the desktop or go to 
the Windows™ Start menu and navigate to McBreach, which normally will be located in 
the McBreach folder. Once McBreach has opened, click File…New. Then enter a name 
for the new McBreach project and save it in the directory of your choosing. All 
McBreach projects will have the file extension. mcb.   
 

V.  Interface 
Main McBreach Window 

Upon opening McBreach, the main McBreach window will become active. The main 
McBreach form is shown in Figure 1.   

Most work for the McBreach project will be performed from the main McBreach 
window. It is a typical Windows™-style interface with a series of menu items and 
convenience short-cut buttons at the top. The main McBreach window is separated into 
five groups. At the top of the window, the first group includes the name of the current 
McBreach project and the unit system used for the current project.   
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Figure 1.  McBreach Main Window 

 



 4

HEC-RAS Association 

The second group contains information about the associated HEC-RAS project and the 
dam or levee that will be simulated probabilistically (Figure 2).   

 
Figure 2.  HEC-RAS Association Group 

 
The HEC-RAS dam breach project must already be set up before McBreach can be 
associated with it.  To associate a HEC-RAS project with your McBreach project, click 
the open button to the right of the HEC-RAS Project name label. This will open a 
Windows™ Explorer dialog. Navigate to the HEC-RAS project file (*.prj) that is desired 
to associate and select that project file. Once the HEC-RAS project is associated, the 
project path and file name will populate the HEC-RAS project label and McBreach will 
automatically assemble the HEC-RAS plans into the HEC-RAS Plan dropdown box. 
Select the plan to run with McBreach. Typically, a truncated plan (see Section VI. 
Truncated HEC‐RAS Model) will be selected to run with McBreach.  All inline structures, 
lateral structures, and SA/2D Area Connections included in the selected HEC-RAS plan 
will be assembled in the HEC-RAS Dam ID dropdown box. Select the dam or levee to be 
breached using McBreach.   

Statistical Inputs 

The next two groups allow the user to set statistical inputs for each of the dam breach 
parameters (Figure 3).   
    
Sampling Method. By selecting “Compute”, McBreach is instructed to randomly select 
the breach parameters of the statistical distributions defined by the user in the statistical 
inputs group. By selecting “Read From Sample File”, McBreach will read in the breach 
parameter for all realizations from a sample file (*.smp). To use this option, a sample file 
must first be written in the correct format.   
 
Each time the user computes (both a full Monte Carlo run or Compute Sample Only), 
McBreach will write a sample file (.smp) that contains all the sampled breach and 
hydrograph parameters. If the sample file is created manually, it must adhere to the 
format as follows:   
 

Inv, B, LSS, RSS, Tf, Init, Cd, Prog, CPipe, ElPipe, InflowMult, InflowDur 
##,##,##,##,##,##,##,##,##,##,##,## 

 
The header row is required as shown above. The second row represents the first 
realization of breach parameters. There should be a row of comma delimited values for 



 5

reach realization. Each ## represents the sampled value that corresponds to the breach 
parameter in the corresponding order on the header. If the user is unsure of the sample 
file format, the sample file (*.smp) created after each McBreach run can be viewed 
directly in a text editor.   
 

 
Figure 3.  McBreach Statistical Input Groups 

 
Failure Mode. Select either Overtopping or Piping. This must be consistent with the 
failure mode selected in the associated HEC-RAS project.  See the HEC-RAS manuals 
for more information on failure mode.   
 
Breach Parameter Tabs. Select the tab for the breach parameter and enter the data. 
Breach centerline is not a parameter used in McBreach.   

 Inv. Final Bottom Elevation 
 B. Final Bottom Width 
 LSS. Left Side Slope 
 RSS. Right Side Slope 
 Tf. Breach Formation Time 
 Init. Starting WS Elevation for failure initiation. Only used if Trigger Failure 

is set to WS Elev 
 Cd. Breach Weir Coefficient 
 Prog. Breach Progression. If probabilistic sampling mode is selected, breach 

progression is set to a uniform distribution, representing a “coin flip” between 
linear function and sine function. In other words, McBreach will randomly select 
either linear or sine.  

 Cpipe. Piping Coefficient. Only used if the failure mode in HEC-RAS is set to 
piping.   
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 ElPipe. Initial Piping Elevation. Only used if the failure mode in HEC-RAS is 
set to piping.   

Sampling Mode. For each breach parameter, select between Deterministic and 
Probabilistic. If Deterministic is selected, enter the value to be used for the selected 
breach parameter for each realization and McBreach will use that exact value for every 
realization in the Monte Carlo run. If Probabilistic is selected, choose the desired 
distribution and enter the required data. When Probabilistic is selected, McBreach will 
randomly sample values about the defined statistical distribution for each realization.     
 
Distribution. Choose a statistical distribution for the selected breach parameter. Uniform, 
normal, triangular and lognormal are the statistical distributions available in McBreach 
Version 5.0.7. More information on the statistical distributions available in McBreach is 
presented in VII. Theory     
 
Statistical Inputs. These values are entered by the user to define the shape of the selected 
statistical distribution. Each distribution has its own set of inputs.   

 Value. Deterministic Sampling Mode. This is the value that McBreach will 
assign for the given breach parameter for all realizations.   

 Minimum. Probabilistic Sampling Mode. Uniform Distribution. This sets the 
minimum bound for a uniform sampling domain. 

 Maximum. Probabilistic Sampling Mode. Uniform Distribution. This sets the 
maximum bound for a uniform sampling domain. 

 Abs. Minimum (Option). Probabilistic Sampling Mode. Normal and 
Lognormal Distributions. Allows the user to set an absolute minimum value that 
McBreach can select during the sampling process. For a given realization, if a 
number less than the absolute minimum is sampled, McBreach will use the 
absolute minimum value. 

 Abs. Maximum (Option). Probabilistic Sampling Mode. Normal and 
Lognormal Distributions. Allows the user to set an absolute maximum value that 
McBreach can select during the sampling process. For a given realization, if a 
number greater than the absolute maximum is sampled, McBreach will use the 
absolute maximum value. 

 Mean. Probabilistic Sampling Mode. Normal and Lognormal Distributions. 
Enter the mean (average) value for the normal distribution. 

 Standard Deviation. Probabilistic Sampling Mode. Normal Distribution. 
Enter the standard deviation for the normal distribution. 

 Min. Probabilistic Sampling Mode. Triangular Distribution. Enter the 
minimum value for the triangular distribution. 

 Max. Probabilistic Sampling Mode. Triangular Distribution. Enter the 
maximum value for the triangular distribution. 

 Mode. Probabilistic Sampling Mode. Triangular and Lognormal Distributions. 
Enter the mode for the triangular distribution. The mode is the statistically most 
frequently occurring value in the sampled set.  
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Options. The following optional methods are available: 
 Monolith Width (Option). Breach width (B) parameter. This option will use 

whatever is sampled for the breach width and round it to the nearest multiple of 
the monolith width value entered. This is more appropriate when simulating 
breaches of concrete dams that typically breach as multiples of monolith widths.  

 Multiple of Breach Height (Option). Breach width (B) parameter. This 
option allows the breach width to be defined as a multiple of the breach height. 
Several breach parameter equations are a function of breach height. If this option 
is selected, enter in values that represent multiples of breach height instead of 
breach widths. When selecting this option, a dam crest elevation will be required. 
McBreach determines the breach height by subtracting the dam crest elevation 
from the sampled breach invert elevation.   

 Erosion Rate (Option). Breach formation time (Tf) parameter. Selecting 
Erosion Rate will change the units for the formation time inputs from hours to feet 
or meters per hour (ft/hour or m/hour). If Erosion Rate is selected, enter erosion 
rates (in ft/hour or m/hour) instead of breach formation time. McBreach will 
divide each sampled breach width by the erosion rate. This provides a sampled 
formation time that is a function of breach width.   

Computational Control 

The last section of the main McBreach window includes computation control information 
(Figure 4).   

 
Figure 4.  Computational Control Options 

 
Sample Size. Enter the number of realizations to be run for the McBreach simulation. The 
number of realizations should be large enough so that statistical convergence on peak 
discharge is achieved. Before running a large number of realizations, it is advised to test 
the performance of McBreach with a small number or realizations first (10 or 20).  
Statistical convergence is discussed in detail in Section VII. Theory 
 
Exceedance Probability Target. By default, McBreach provides output for seven standard 
exceedance probabilities for peak discharge: 1%, 5%, 10%, 50%, 90%, 95% and 99%. 
McBreach has the ability to produce an additional exceedance probability beyond the 
seven default values.  If output for another exceedance probability is desired, enter it in 
this input box.     
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Continue from Previous Simulation. If upon completion of a McBreach simulation, it is 
determined that more realizations are desired, the user can continue the previous 
McBreach simulation by checking this box. The number of realizations in the Sample 
Size input box will be added to the previous simulation. This function is particularly 
useful once a simulation of a large number of realizations is completed, and the user 
determines the desired level of statistical convergence has not been achieved. There is no 
limit to how many times the user can continue from a previous simulation. When this 
option is selected, after selecting Compute, McBreach will read the previous simulation 
from the McBreach log output file (*.mcblog.out). Therefore, the user must already have 
an existing log output file in the McBreach project directory to use this option.    
 
Compute. Once all input data is entered, select Compute to run a McBreach simulation. It 
is good practice to save data prior to selecting Compute. 

Menu Items 

The menu items include typical Windows™-type menu items: File, Options, Output and 
Help. The convenience buttons below the menu items gives the user quick one-touch 
access to some of the more common tools or options that will be used.   
 
File Menu 

The File menu contains typical options for creating, opening and saving McBreach 
projects (Figure 5). 

 
Figure 5.  File Menu 

 
New. Creates a new McBreach project. All input boxes will be cleared, and defaults will 
be reset.   
 
Open. Opens a file-select dialog window which will allow the user to search for and open 
existing McBreach projects with the file extension *.mcb. 
 
Save. Saves the current McBreach project and all the input data both on the Main 
McBreach window and the Inflow Hydrograph window.   
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Save as. Creates a new McBreach project while preserving all of the current input data. 
 
Exit. Closes McBreach. If McBreach has any unsaved changes, the user will be prompted 
to save before McBreach exits. 
 
Options Menu 

The Options menu contains a range of options for the user to consider (Figure 6). 
 
Unit System. Select between US (United States customary) units and SI (System 
International) units. This must be consistent with the unit system used in the HEC-RAS 
project. 
 
Open Last Project on Startup. Provides a link in the Window™’s registry for the last 
saved McBreach project. When this is selected, the last saved McBreach project will 
automatically open when starting McBreach. 
 

 
Figure 6.  Options Menu 

 
Limit Piping Elevation to Invert Elevation. Depending on the statistical ranges provided 
in the dam breach parameters, it may be possible for McBreach to randomly sample an 
initial piping elevation that is lower than the randomly sampled dam breach invert 
elevation. Although this is not a logical occurrence, this option is available to prevent this 
from occurring. When this option is selected, if McBreach returns an initial piping 
elevation lower than the sampled breach invert elevation, the piping elevation will be set 
to the breach invert elevation.   
 
Preserve Peak for Inflow Duration Adjustment. When performing probability on the 
duration of the inflow hydrograph, the peak discharge for the sampled inflow hydrograph 
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can be adjusted (downward) slightly due to the new spacing of hydrograph points. By 
selecting this option, McBreach will replace the peak discharge in the newly sampled 
hydrograph with the original hydrograph’s peak discharge. All other points on the 
sampled hydrograph will remain as sampled.     
 
Show HEC-RAS While Computing. While McBreach is running, the HEC-RAS 
computations will show for each realization. This can be useful to verify that HEC-RAS 
is computing successfully and to get a sense for how long each HEC-RAS run is taking 
for each McBreach realization. While selecting this option has very little effect on the 
computation time for any one realization, it will slightly add to the computer’s 
computational burden and can lengthen an overall McBreach simulation (especially when 
running a large amount of realizations). It is suggested to select this option when doing 
some preliminary small batch tests, but not for the full run of thousands of realizations.   
 
Show Breach Hydrograph While Computing. This option displays a graph during the 
McBreach simulation of an ensemble of all the computed breach hydrographs. Selecting 
this option takes a large amount of computational effort and memory and will 
progressively slow the McBreach simulation considerably. It may not be noticeably 
slower at the beginning of the McBreach simulation, but over time it will increase each 
realization’s split time substantially. Only select this option for testing a relatively small 
amount of realizations. This option is useful for obtaining a graphical image of the range 
of breach outflow hydrographs that are computed during the McBreach simulation 
(Figure 7).   
 

 
Figure 7.  Computed Breach Hydrographs 
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Show Inflow Hydrograph While Computing. This option displays a graph during the 
McBreach simulation of an ensemble of all the sampled inflow hydrographs (refer to 
inflow hydrograph discussion). Selecting this option takes a large amount of 
computational effort and memory and will progressively slow the McBreach simulation 
considerably. It may not be noticeably slower at the beginning of the McBreach 
simulation, but over time it will increase each realization’s split time substantially. Only 
select this option for testing a relatively small amount of realizations. This option is 
useful for obtaining a graphical image of the range of sampled inflow hydrographs during 
the McBreach simulation. Figure 8 illustrates an example of an ensemble of inflow 
hydrographs. 
 

 
Figure 8.  Ensemble of Inflow Hydrographs 

 
Compute Sample Only. Select this option to ONLY compute the sample set of breach 
parameters and inflow hydrograph multipliers for the entire sample size. HEC-RAS 
computations will not be performed. This option is useful to preview the sampled breach 
and inflow parameters and can also be used to evaluate the erosion rate/headwater depth 
(ER/Hw) relationship. When this option is selected, McBreach creates the sample set and 
writes it to a sample file. The results of the sampling can be viewed in the computation 
window and is also available to evaluate in the ER/Hw plot. 
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Inflow Hydrograph. Select this option to open the Inflow Hydrograph sampling window. 
This option allows the user to treat the inflow hydrograph as an uncertain input 
parameter. The inflow hydrograph will be sampled for each realization of the McBreach 
simulation by applying a flow multiplier and a duration multiplier. Both multipliers are 
randomly sampled for each realization based on their statistical distributions as 
determined by the user. Select the mode and distribution and fill in the required input 
parameters. Uniform, triangular and normal distributions are available for McBreach 
Version 5.0.7. Figure 9 illustrates the inflow hydrograph input window.   
 
Once the inflow hydrograph inputs are entered, the user can plot the inflow hydrograph 
distribution by clicking the Plot button (Figure 10). During the McBreach simulation, the 
user can track the sampling of inflow hydrographs by selecting the option “Show Inflow 
Hydrograph while Computing”, found in the Options menu of the main McBreach 
window.   
 

 
Figure 9.  Inflow Hydrograph Window 
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Figure 10.  Inflow Hydrograph Distribution 

 
Output Menu 

The Output menu contains four plots and one table for evaluating output (Figure 11). The 
plot window contains a Table tab for viewing tabular data. The values in the table can be 
selected by clicking and dragging over a range of values. Once highlighted, the selected 
values can be copied by pressing the Ctrl and the C keys simultaneously on the keyboard 
(Ctrl+C), which stores them in the Windows™ Clipboard. They can then be pasted into 
another software application (i.e. spreadsheet program) by pressing the Ctrl and V keys 
simultaneously (Ctrl + V).   
  
 

 
Figure 11.  The Output Options 
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Peak Flow Distribution Plot. Peak Flow Distribution produces a histogram plot grouping 
peak flow discharges as shown in Figure 12. The values are read directly from the 
*.mcb.outQ file located in the same directory as the McBreach project file. Should the 
*mcb.outQ file not exist, the user must run McBreach to produce the file.   
 
Ideally, with enough realizations and a small enough bin interval, the Peak Flow 
Distribution plot should resemble a normal distribution and is typically slightly skewed to 
the right. There will usually be some extreme peak flows returned on the right side of the 
plot. The values labeled on the x-axis represent the smallest value in that bin. Under the 
Options menu on the Peak Flow Distribution plot, the user has some control over the look 
of the histogram plot by changing the bin interval. The bin interval sets the size of each 
class represented by individual histogram bars. The more realizations that have been run, 
the smaller the bin interval can be selected and still provide a useful plot. Also provided 
under the Options menu is the ability to copy the plot to the Windows™ clipboard. There 
it can be pasted into many different software applications (i.e. word processors, 
spreadsheets, presentation software).   
 
The Table tab on the upper left of the window provides all of the peak flows numerically 
in a table format.   
 

 
Figure 12.  Peak Flow Distribution Plot 

 
Peak Flow Exceedance Plot. Peak Flow Exceedance provides a plot of exceedance 
probability versus peak flow (Figure 13). The values are read directly from the 
*.mcb.outQ file located in the same directory as the McBreach project file. Should the 
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*mcb.outQ file not exist, run McBreach to produce it. The Table tab displays a table of 
selected exceedance probabilities and their respective peak flows.   
 

 
Figure 13.  Exceedance Flows 

 
Breach Parameter Distribution Plot. Opens a plot that displays the distribution of all 
sampled breach parameters. The dropdown box on the right allows the user to view each 
of the breach parameters. With enough realizations, the distribution plot should follow 
the same shape as the selected distribution.   If the distribution plot does not follow the 
shape of the selected input distribution, that is a good indication that more realizations is 
needed. Figure 14 demonstrates a distribution plot of breach bottom widths, using a 
lognormal distribution.   
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Figure 14.  Breach Parameter Distribution Plot 

 
ER/Hw Plot. Opens a plot that shows the relationship between erosion rate (ER) and the 
Headwater (HW) for every realization. The erosion rate is defined by Von Thun and 
Gillette (1990) as the average breach width divided by the breach formation time 
(Bavg/Tf). Expanding upon Von Thun and Gillette, the State of Colorado Guidelines for 
Dam Breach Modeling (Colorado 2010) suggests a minimum ER/Hw of 1.6. If ER/Hw is 
less than 1.6, then either the failure time or the breach width should be adjusted until 
ER/Hw is greater than 1.6. McBreach provides a warning if more than 5 percent of the 
sampled breach parameters produce an ER/Hw relationship less than 1.6. Colorado 
(2010) also suggests a maximum ER/Hw of 21. If the ER/Hw is greater than 21 then the 
user should reconsider the selected breach parameters. McBreach provides a warning if 
more than 5 percent of the sampled breach parameters produce an ER/Hw greater than 
21. Figure 15 provides an example ER/HW plot. Notice that more than 5 percent of the 
ER/HW samples are less than 1.6. In this case, ER should be increased by either 
increasing breach width (B) or decreasing the formation time (Tf).  
 
This plot requires the use of the “starting WS elevation for failure initiation” breach 
parameter (Init). If the user selects formation time to be computed from sample erosion 
rates, McBreach will use the sampled erosion rate for this plot.   
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Figure 15.  Erosion Rate to Headwater Depth (ER/Hw) Ratio 

  
This method should only be considered for earthen embankment dams. Every dam is 
different, and it is up to the user to determine if the ER/Hw evaluation as presented by 
State of Colorado (Colorado 2010) is appropriate to use.   
 
EP Breach Parameter Sets Table. The Exceedance Probability (EP) Breach Parameter 
Sets Table produces a summary table of the EP peak discharges, the realization where 
that peak discharge occurred, and the breach parameter sets that produced each peak 
discharge in the Monte Carlo exercise. All data presented in this table is extracted from 
the McBreach log output file (*.mcbLog.out). This table provides a convenient way to 
establish plans for specific EP breach simulations, rather than searching the log output 
file. Figure 16 provides an example EP Breach Parameter Sets Table. 
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Figure 16.  EP Breach Parameter Sets 

 
View Log Output File. Selecting this option will open a window displaying the log output 
file created after a McBreach simulation. The log output file is simply a copy of the 
computation window output. It is stored in the McBreach project directory and has the 
extension .mcbLog.out. This file can also be viewed in any text editor.   
 
Help Menu Item 

The Help menu includes an About window that presents basic information about the 
McBreach software. It also provides a convenience link to the User’s Manual.   

Shortcut Buttons 

At the top of the McBreach window, there are several short cut buttons for the more 
commonly used features. The shortcut buttons are presented in Figure 17.   
 

 
Figure 17.  McBreach Shortcut Buttons 

New 

New will clear all the input boxes and start a new McBreach project. 
 
Open McBreach 

Opens a Windows™ file-open dialog to search for and open an existing McBreach 
project. Opens files with the *.mcb extension. 
 
Save 

Saves the current McBreach project to the *.mcb file.   
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Inflow Hydrograph Statistics 

Opens the optional Inflow Hydrograph Statistics window. This allows the user to 
randomly sample scaling factors about statistical distributions for both inflow hydrograph 
magnitude and duration.   
 
Standard Deviation Help 

Opens a help window to assist in determining the standard deviations to use for normal 
distributed breach parameters (Figure 18).   
 

 
Figure 18.  Standard Deviation Help Window 

 
Enter the mean value for the breach parameter. In the  + __ input box, enter a value 
that defines the confidence range of the sample set (typically use a value of 2 or 3). Two 
standard deviations represent 95.4 percent confidence in the defined range, three standard 
deviations represent 99.7 percent confidence. Selecting the Compute button returns the 
standard deviation value to use in the statistical inputs window for the normally 
distributed breach parameter.   
 
Open the Associated HEC-RAS Project 

Opens up the associated HEC-RAS project for viewing and/or editing. Make sure to save 
and close HEC-RAS before computing McBreach.  
 

VI. Truncated HEC-RAS Model 
Running HEC-RAS in a Monte Carlo exercise requires many thousands of realizations to 
achieve statistical convergence of the mean and standard deviation (and skewness and 



 20

kurtosis, if desired). McBreach produces plots of computed mean, standard deviation, 
skewness, and kurtosis of the computed peak discharges to help the user determine if 
convergence has been met (see Section VII. Theory for more information). Ten thousand 
realizations are generally a good first start for a typical dam breach model. If the HEC-
RAS dam breach model takes one minute to run (this is certainly within a normal range), 
then a 10,000 realization Monte Carlo analysis would take nearly seven days to complete! 
To make probabilistic dam breach modeling convenient, the user should target it as an 
overnight exercise. While this is not always possible for every HEC-RAS dam breach 
model, most HEC-RAS dam breach models can be truncated to run fast enough to make 
McBreach an overnight exercise. A good target would be to get an individual 
realization’s run time down to five seconds or less. Five seconds at 10,000 realization is 
just under 14 hours. That certainly falls within the realm of an overnight exercise. 
Because McBreach is fully automated, it can be set to run at the end of the day, and it 
will be finished the next day.  
 
The truncated version of the model is only needed during the McBreach simulation, when 
it is running thousands of realizations. After McBreach is finished, the user can replicate 
the breach parameter sets for the EP peak flows, put them in the full model and map the 
inundation extents for them. This will typically only be five or six breach parameter sets 
(e.g. 0.2% exceedance probability, 1%, 5%, 10%, 50%).  
 
So how does the user get a HEC-RAS dam breach model that takes minutes or hours to 
run down to a five second (or less) run time? The following section offers some 
suggestions for common ways to sufficiently truncate the model: 
 

 Remove the Downstream Reach   
Because McBreach obtains peak flows from the dam that is being breached, there 
is no need for routing the reach downstream of the dam for the probabilistic runs.   
 
If the geometry downstream of the dam is a 1D reach, remove all of the cross 
sections in that reach except for a few just below the dam; enough to provide an 
accurate tailwater condition. The number of cross sections needed depends on the 
steepness and conveyance of the reach, the discharge and the height of the dam. A 
good starting point is to leave enough cross sections to span a length of 
approximately five main channel widths. To verify if there are enough cross 
sections, run several dam breach simulations with varying sets of breach 
parameters with both the truncated and full models. Compare the discharge 
hydrograph computed with the truncated versus the full model. If they are 
different, then either adjust the downstream boundary condition or return some 
cross sections to the truncated model to extend the downstream reach a little 
more. Figure 19 and Figure 20 show a full and truncated 1D model.   
 
If the geometry downstream of the dam is a two-dimensional (2D) area, the user 
has two options for truncating. The first option is to remove most of the 2D area 
downstream of the dam and leave a small area below the dam to set up a good 
tailwater condition. The second option would be to replace the downstream 2D 
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area with a 1D reach in the truncated model. Both options require the user to 
verify the tailwater condition for a wide variety of breaches as previously 
discussed.  Figure 21 and Figure 22 provide a full and truncated 2D model.   

 
Figure 19.  Full Model Geometry for Bear Lake 

 
Figure 20.  Truncated Model Geometry for Bear Lake 
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Figure 21.  Full Model for Muncie 2D Dam Breach 

 

 
Figure 22.  Truncated Model for Muncie 2D Dam Breach 
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 Uncheck Post-Processing 
McBreach reads peak flows from the plan hdf file, not the output file. The plan 
hdf file is created after the unsteady flow computations are completed, but before 
post processing begins. Therefore, it is not necessary to have post processing 
checked as a program to run, when running the McBreach simulation. This can 
significantly reduce the overall simulation time of each realization.   
 

 Increase the Computation Interval 
With a large portion of the downstream reach removed, it is likely the user can 
increase the computation interval and still maintain numerical stability in the 
truncated model. Be careful! Because the model is stable, does not mean it is 
computing correctly. When increasing the computation interval, it is important to 
verify that both the truncated and full models produce the same dam breach 
hydrograph for a variety of breach parameter sets (within reason). If they are 
different, try reducing the computation interval until the full model and the 
truncated model produce similar dam breach hydrographs.   
 

 Use Diffusion Wave Equation Set 
If a 2D downstream reach is being used, consider using the Diffusion Wave 
equation set for the 2D areas of the truncated model. The Diffusion Wave 
equation set runs much faster and is less prone to generate errors than its Full 
Momentum counterpart. Make sure that the truncated model still replicates the 
full model’s breach outflow hydrograph for a range of dam breach parameter sets.   
 

 Trim the Simulation Time 
Because McBreach only reads peak discharges from the breach hydrograph at the 
dam, the simulation only needs to be long enough to capture the peak of the 
breach hydrograph. The remainder of the simulation can be trimmed to reduce 
computation time. Make sure to run a simulation in the full model with the 
highest possible breach formation time that may be sampled during the Monte 
Carlo process. Examine that breach hydrograph at the dam location to determine t 
the simulation time can be trimmed. This simulation is demonstrated in Figure 23.   
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Figure 23. Dam Breach Hydrograph for Full Model.   

Note:  Simulation time to the right of the red arrow is not necessary for the truncated model. 
 

VII. Theory 
Monte Carlo Method 

McBreach uses the Monte Carlo Method to determine EP for peak flow rates from dam 
breach events. The Monte Carlo Method was developed in the 1940s during nuclear 
weapons research (Goodell 2012). Its applications are far and wide, ranging from 
economics, to engineering, and to gaming. The Monte Carlo Method works by randomly 
sampling input values to a mathematical solution and solving for the outcome over and 
over until the probability of a specific outcome converges on a single value. Each 
solution in a Monte Carlo Method experiment is called a realization.   
 
The coin flip is perhaps the most basic analog for demonstrating the Monte Carlo 
Method. It is known that the probability of getting heads or tails when flipping a coin is 
exactly 50 percent. However, it is also quite plausible that if one were to flip a coin five 
times, the result may be one-head and four-tails. In that case, the result was 20 percent 
heads and 80 percent tails. Or maybe two-heads and three-tails. Etc., etc. But the 
probability of getting either heads or tails is still 50 percent for each and every coin flip. 
And if the coin was flipped enough times, the result would be exactly 50 percent heads 
and 50 percent tails. The exercise of flipping enough coins so that the outcomes 
ultimately define the probability is the theory behind the Monte Carlo Method.   
 
In dam breach modeling, much more input is being used than with a binary coin flip. 
Except for breach progression, none of the breach parameters are binarily and discretely 
distributed like a coin, but rather follow a continuous normal distribution, or a uniform 
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distribution; maybe even a triangular or lognormal distribution. Instead of one input 
parameter (i.e. the coin flip), there are eight breach parameters in McBreach when 
simulating an overtopping breach event and ten breach parameters when simulating a 
piping event. Each breach parameter must be randomly sampled about a user-defined 
statistical distribution. So, while demonstrating statistical convergence for a coin flip may 
require tens or hundreds of flips (to a fairly precise level), demonstrating statistical 
convergence for a peak flow from a dam breach event can take thousands or tens of 
thousands of model simulations.   
 
In most HEC-RAS dam breach models, statistical convergence in a Monte Carlo Method 
run requires between 5,000 and 10,000 realizations-a realization being a single HEC-
RAS simulation. This can be demonstrated with the following plot that shows 
convergence on the mean and standard deviation of peak dam breach outflow (Figure 24). 
It is recommended that a McBreach simulation use 10,000 realizations, but that the user 
would evaluate statistical convergence to ultimately determine the correct number of 
required realizations. Viewing the statistics during the McBreach run can help determine 
the required number of realizations.  

 
Figure 24.  Statistical Convergence of Mean and Standard Deviation of Peak Dam Breach Outflow 

Statistical Distributions 

The statistical distributions guide McBreach’s random sampling of the breach 
parameters. The distributions define a parameter’s central tendency, its variance, and 
even its upper and lower bounds. There is very little known about the true statistical 
distributions of breach parameters. There has been little research here; however, 
knowledge of site conditions and some common sense can lead to good approximations 
of the distribution of any breach parameter. Froehlich (2008), Wahl (2001) and 
Ahmadisharaf et. al. (2016) discuss breach parameter uncertainty.   
 
McBreach Version 5.0.7 has four statistical distributions from which to choose: 
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Uniform Distribution 

The uniform distribution, also called a rectangular distribution because of the shape of its 
probability density function (pdf), is a symmetrical statistical distribution that assumes 
within a defined range, all results have an equally probable chance of occurrence. In other 
words, there is no central tendency. Between a given minimum and maximum value, 
there is no information to assume any value is more likely to occur than any other.   
 
The distribution of the initial piping elevation breach parameter can logically be defined 
with a uniform distribution. If there is no information 
on a perceived or known weakness in the dam that 
could lead to a piping event, then in theory, piping 
could begin anywhere between the reservoir’s water 
surface elevation and the toe of the dam-and all piping 
elevations would be equally probable. This represents 
a uniform distribution. 
 
The uniform distribution in McBreach requires the user input a minimum value and a 
maximum value to define the range over which values can be sampled.  
 
Triangular Distribution 

The triangular distribution is an asymmetric distribution that defines a central tendency. 
The central tendency (or assumed highest probability value) is defined as the mode of the 
sample set. The mode is the value that most frequently occurs. An advantage of the 
triangular distribution is its inherent minimum and maximum values. The tails do not 
extend to infinity as with a normal distribution. Therefore, if we have information about 
an absolute minimum or maximum value for a given breach parameter, those values can 
be directly assigned to the triangular distribution without abrupt truncation. Another 
advantage is its ability to present a skewed 
distribution. This can be very important for smaller 
breaches or faster forming breaches, where the 
distribution may be positively skewed because of a 
zero-value limitation (i.e. it is impossible to sample 
less than zero).   
 
A disadvantage of the triangular distribution is its 
tendency to oversample towards the extremes of the range and under sample near the 
central tendency. While triangular distributions are simple to use, they are not typically 
representative of random sampling with a central tendency.  
 
The triangular distribution in McBreach requires the user to input minimum and 
maximum values, as well as a mode. The mode might represent an average of all 
computed breach widths from a range of breach width parametric equations.    
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Normal Distribution 

The normal (or Gaussian or bell-shaped) distribution is a very commonly used symmetric 
distribution that defines a central tendency. A normal distribution accurately represents 
an uncertainty distribution for many of the natural phenomena found in science. The 
central tendency (or assumed highest probability value) is defined as the mean, , of the 
sample set. The range of results is defined by the standard deviation, . Any breach 
parameter that can be assumed symmetric about a central tendency, can be well defined 
by a normal distribution.   
 
The normal distribution requires the user to enter a mean and standard deviation. The 
mean may represent an average of all computed breach 
widths from a range of breach width parametric 
equations. It may also represent the user’s best 
assumption of the breach weir coefficient. The standard 
deviation can be backed out from the confidence range. 
Example: suppose the user has an average breach width 
of 20 meters and confident to 99 percent that the breach 
width would not be more or less than 10 meters from 
the average (i.e. between 10 and 30 meters). Because +-3 represents 99.7 percent of 
expected samples, the user could assign 3 = 10 meters, which results in a  of 3.33 
meters.   
 
The normal distribution can also be truncated with optional absolute minimum and 
maximum values. These represent the upper and lower bounds of a sampled distribution 
and allow the user to prevent McBreach from sampling outside of a desired range. For 
example, a breach width cannot possibly be less than zero. So, while the probability of a 
breach width equaling zero may be very low, in theory, even a negative value could be 
sampled. Using an absolute minimum value of zero would prevent this. Same thing on 
the other end of the distribution. There may be bedrock in the foundation that would limit 
the breach width growth. This width could be assigned as the absolute maximum.   
 
Lognormal Distribution 

The Lognormal distribution is a very commonly used 
asymmetric distribution that defines a central 
tendency, but also naturally limits sampling to 
positive values and can be positively skewed. With a 
lognormal distribution, the random variable’s 
logarithm is normally distributed. The lognormal 
distribution is used commonly for defining samples 
in biology and medicine, economics and hydrology, 
among many other applications.  
 
The Lognormal distribution has the same skewing advantage of a triangular distribution, 
but without the disadvantage of under sampling near the central tendency or 
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oversampling near the extremes. A lognormal distribution is typically more 
representative of natural occurrence than is a triangular distribution.   
 
The Lognormal distribution requires the user to enter a mode and a mean. The mode 
represents the most likely value, while the mean represents an average of the sampled set. 
The mean must always be greater than the mode for the lognormal distribution and will 
affect how skewed the lognormal distribution is. An absolute minimum and maximum 
value can be used as an option, but if the absolute minimum and/or maximum are too 
close to the mean value, it is possible to oversample on the extremes. When the absolute 
minimum or maximum are exceeded, McBreach will use the minimum or maximum 
value.   
 

VIII. Running McBreach 

To run McBreach, the user must first have a working and robust HEC-RAS model. For 
optimized speed during the McBreach simulation, the user should prepare a truncated 
model. Before running McBreach, ensure the HEC-RAS model can compute the full 
range of breach parameter sets that it may encounter during the Monte Carlo exercise 
without going unstable. To accomplish this, the user should run both a minimum flow set 
of breach parameters, and a maximum flow set of breach parameters (meaning the set of 
breach parameters that will produce the lowest and highest peak discharges form the 
breach). Ensure that both the minimum and maximum HEC-RAS plans produce minimal 
errors and run fast. From there, the user can optionally create a truncated version of the 
model as discussed in Section 6. Once the HEC-RAS model is ready, the user can 
proceed to set up and run McBreach. 
 
Setting up McBreach is a six-step process: 

1. Save a new McBreach project. 
2. Associate the HEC-RAS model, plan and dam that the user wishes to connect 

with the new McBreach project. If a truncated plan is created, point to that plan.  
3. Choose the sampling method (compute or read a sample file), select overtopping 

or piping, and then set up the statistical distributions for each of the breach 
parameter tabs. If an overtopping breach is being simulated, the piping breach 
parameters are not required.   

4. Set the sample size and the optional exceedance probability target and press 
compute.   

5. Once computations are complete, open the Exceedance Probability (EP) Breach 
Parameters table. Create HEC-RAS plans with the full model by copying the 
breach parameter sets from each of the exceedance probability results in the table 
and pasting into each HEC-RAS plan’s respective breach parameter editor.   

6. Rerun the full model plans to obtain breach output and mapping for each of the 
EP breach parameter sets.   

 
When Compute is selected, the Computation Window will pop up showing a constant 
stream of text messages that inform the user of the McBreach simulation progress. The 
first information displayed in the Computation Window will be the results of the sampled 
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breach parameters (Figure 25). To help ensure statistical convergence, the user should run 
enough samples so that the input statistics and the computed statistics are close to the 
same. For example, the computed mean should be the same (or close to it) as the input 
mean. The same applies for standard deviation. If the input and computed means (or 
standard deviations) are too far apart, the user should run a larger sample set.   
 
Following the breach parameter sampling results, McBreach will begin displaying the 
results of each realization, one at a time (Figure 26). While the messages are scrolling 
through for each realization, the user can review the sampled breach parameters and 
resulting peak breach discharge and ensure the numbers are logical. If something does not 
appear correct, press the Quit button at the bottom to stop the McBreach run and review 
the inputs.   

 
Figure 25.  Breach Parameter Sampling Results Shown in Computation Window 
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Figure 26.  Results of Each Realization Shown in Computation Window 

 
Select the Statistics button (Figure 27) to track the peak outflow statistics (to monitor 
peak flow convergence). This will allow the user to track the progression of the 
convergence of the first through fourth statistical moments while McBreach is running. 
Statistics can be turned on or off anytime during the McBreach simulation. 
 
The four statistical moments are mean, standard deviation, skewness and kurtosis. These 
four properties define the shape of the resulting distribution of peak flows. Mean will 
converge first, followed by standard deviation, then skewness and finally kurtosis. The 
user can view the convergence either by absolute statistics or by percent difference. At 
the beginning of the simulation, the statistical moments will be bouncing around quite a 
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bit, but after several realizations, the user will see the mean of peak flows begin to settle 
out at a constant value. Each higher order statistical moment will require more 
realizations to achieve convergence. Running 10,000 realizations will typically achieve 
convergence for all four statistical moments.   
 

 
Figure 27.  Peak Flow Statistics Monitoring 

 
The HEC-RAS button at the top left of the Computation Window will show HEC-RAS 
running during each realization. This feature can be turned on or off any time during the 
McBreach simulation. With it turned on, the user will see HEC-RAS open, run 
computations and close for each realization. This is a good way to ensure HEC-RAS is 
computing normally during the McBreach simulation. Click the HEC-RAS button again, 
and the HEC-RAS computations will resume running in the background. McBreach will 
run slightly faster with the HEC-RAS computations hidden. It is best to only temporarily 
view the HEC-RAS computations to verify its computing correctly, then go back to 
hiding them.   
 
The bottom of the Computation Window will display some information about the timing 
of the McBreach run. Here the user will view McBreach display the starting date and 
time of the McBreach run, the approximate date and time of completion, the approximate 
total time for completion, the approximate time remaining, and the average split time for 
each realization. These values will be updated after each realization. The more 
realizations that have been run, the more accurate the timing values will be. After just a 
few realizations, the user should have a very good idea of how long the McBreach run 
will take in total.   
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Figure 28.  McBreach Simulation Timing 

 
Once the McBreach simulation is complete, the user can close the computation window 
(it is not necessary). If the computation window is closed and the user would like to view 
it again, from the main McBreach window, select Output…Log Output File. However, 
the Log Output File will not show the statistical convergence on peak flow. Therefore, 
once the user closes the Computation Window the user will not be able to pull up the 
statistical convergence plots unless the user reruns McBreach.   
 

IX.  Troubleshooting 
As with any model, if it produces strange results, check the input data. The following are 
common mistakes that can make McBreach not operate as intended: 

 Receive message saying there is already another instance of HEC-RAS open--
ensure there are no other HEC-RAS projects open. If it appears that there are none 
open, then HEC-RAS is running in the background. This typically happens if 
McBreach abruptly shuts down. The user can remove the other instance of HEC-
RAS from your Task Manager. If that does not work, reboot the computer.   

 If peak flow results do not change for each realization, it could be that HEC-RAS 
is producing an error during each run. Try running HEC-RAS on its own. An 
error message stating that a certain file is inaccessible, means that it is likely open 
as a zombie in the background of Windows™. A computer reboot will fix this. 

 Another reason peak flows might not change in the McBreach output is if the 
HEC-RAS plan hdf file is open in HDF®View, or otherwise being used external 
to HEC-RAS during a McBreach run. Make sure the plan hdf file is closed and 
not being used by another software application while McBreach is running. 

 If nothing is seen on an output histogram plot, try changing the bin interval in the 
Options menu item of the plot.    
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